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DIE PHILOSOPHIE VON ALTIUM DESIGNER
Das Kernprinzip von Altium Designer ist ein einheitliches Konzept für PCB-Design. In der Umsetzung dieses Ansatzes werden 

Sie feststellen, dass unser Werkzeug sich von vielen der derzeit verfügbaren, herkömmlichen Alternativen unterscheidet. Bei 

diesen finden Sie noch eine Reihe von separaten Prozessen vor, die in unserem Workflow für eine erfolgreiche PCB-Entwicklung 

zusammengeführt sind.

Als Eagle™-Anwender sind Sie sicherlich an die Arbeit mit einem Werkzeug gewöhnt, mit dem Sie die grundlegenden Arbeiten 

am Schaltplan und dem PCB erledigen können. Wie aber bewältigen Sie die heutigen Anforderungen, wenn es um das High-

Speed-Design geht oder Vorgaben der Mechanik-Abteilungen berücksichtigt werden müssen? Mit einem Satz Gerber-Files 

ist es hier meist nicht getan; Stücklisten für Einkauf und Produktion werden ebenso benötigt wie Dokumentationen für das 

gesamte Design, die den unterschiedlichen Beteiligten mit ihren individuellen Anforderungen zur Verfügung gestellt werden 

müssen. Selbstverständlich lassen sich alle diese Aufgaben auch mit Werkzeugen von Drittanbietern erledigen, aber ist dieser 

Ansatz wirklich effektiv? Dies ist die Frage, die wir uns gestellt haben, seit wir uns mit dem PCB-Design befassen.

Als wir den Altium Designer geschaffen haben, wollten wir dem Entwickler das Erlebnis präsentieren, die vollständige und 

effiziente Kontrolle über alle Arbeitsabläufe im gesamten Design-Prozess zu bekommen. Um dieses Ziel zu erreichen, mussten 

auch wir uns überlegen, welche einzelnen Aufgaben zu einem kompletten PCB-Design-Erlebnis für den Entwickler dazugehören. 

Im Rahmen unseres ganzheitlichen Ansatzes haben wir die folgenden Prozesse in einer gemeinsamen Oberfläche verbunden:

 � Schaltplaneingabe

 � Leiterplatten-Layout

 � Management der Designdaten

 � Regeln und Vorgaben

 � Stücklisten

 � Integration der Lieferkette

 � Änderungsverwaltung

 � MCAD-Kollaboration

 � Fertigungsdokumentation

Durch die Verknüpfung dieser Elemente in einer einzigen, allumfassenden Oberfläche wird das Arbeiten und das Hin-und 

Herschalten zwischen den Aufgaben so einfach wie das Auswählen einer Datei. Den Rest übernimmt das Werkzeug und gibt 

Ihnen alles an die Hand, was Sie für die jeweilige Aufgabe benötigen. Unser einheitlicher Ansatz für das PCB-Design ist seit 

mehr als 30 Jahren durch Forschung und Entwicklung kontinuierlich gewachsen. Wie wir finden, ist dies nach wie vor der 

effizienteste Weg Elektronik zu entwickeln. Diese Philosophie trifft nicht nur 

für den einzelnen Entwickler zu, sondern für das gesamte Design-Team. 

Mehrere Entwickler können verschiedene Aufgaben am gleichen Projekt und 

in der gleichen Arbeitsumgebung erledigen. Ein Datenaustausch zwischen 

unterschiedlichen Design-Umgebungen gehört der Vergangenheit an.

Genießen die Reise in die Welt von Altium Designer.

Christian Keller, Technical Sales Manager & das Altium Designer Team.
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VORBEREITUNG FÜR DEN IMPORT VON EAGLE™-DATEIEN

INSTALLATION DES IMPORTERS

Bevor man Eagle™-Dateien importieren kann, muss sichergestellt sein, dass der Eagle™ Importer installiert ist. Mit den folgenden 

Befehlen kann man überprüfen, ob der Importer in Altium Designer verfügbar ist:

1.  Altium Designer öffnen

2.  File » Import Wizard auswählen.

3.  Next anwählen.

Die nächste Seite “Select Type of Files to Import” listet die installierten Importer.

Auswahl des Dateityps im Altium Designer Import Wizard

Während der Installation von Altium Designer kann ausgewählt werden, welche Im- und Exporter installiert werden sollen. 

Der Eagle™ Importer ist normalerweise Bestandteil einer Standard-Installation von Altium Designer und muss nicht manuell 

ausgewählt werden.

Wenn der Eintrag “EAGLE Projects and Designs” in der oben gezeigten Liste doch fehlen sollte, dann wird er folgendermaßen 

hinzugefügt:

1. Get More Importers am unteren linken Rand der Import Wizard Dialog-Box auswählen. Dies öffnet den Extensions & 
Updates Tab innerhalb der Altium Designer Umgebung.

http://www.altium.com
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Der Abschnitt Extensions & Updates in Altium Designer

2. Configure auf der rechten Seite auswählen und zum Bereich Importer/Exporter scrollen. 

3. Den Eintrag EAGLE aktivieren.

Aktivierung des Eagle® Importers im Bereich Extensions & Updates von Altium Designer

4. Ganz nach oben zurückscrollen und Apply anwählen. Altium Designer muss neu gestartet werden, um die Installation 

abzuschließen.

5. File » Import Wizard auswählen. Der Importer sollte nun in der Liste erscheinen. 

Ist der Importer installiert und gelistet, kann mit der Vorbereitung der Eagle™ Dateien begonnen werden.

UNTERSTÜTZTE EAGLETM VERSIONEN & DATEIFORMATE

Der Eagle™ Import Wizard für Altium Designer unterstützt das mit Eagle™ V6 eingeführte XML-Dateiformat.

Anmerkung: Schaltplan- und PCB-Daten im Eagle™-Binärformat (V5.x und älter) lassen sich einfach in das XML-Format 

konvertieren, indem man sie in Eagle™ V6.x (und später) neu abspeichert. Wenn Sie diese Möglichkeit nicht haben, wenden Sie 

sich bitte an Ihren örtlichen Altium-Repräsentanten.

http://www.altium.com
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ÜBERSETZUNG DER DESIGN-DATEN

ÜBERSETZUNG VON EAGLE™ *.SCH-SCHALTPLANDATEIEN UND *.BRD PCB-DATEIEN 
NACH ALTIUM DESIGNER
1.  Menüpunkt File (oben links) » Import Wizard auswählen.

2. Die Import Wizard Dialog -Box erscheint. Zum Fortfahren Next auswählen.
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3. EAGLE Projects and Designs auf der Select Types of Files Seite auswählen und auf Next klicken.

4. Auf Add klicken und die zu übersetzende *.sch- und/oder *.brd Dateien im entsprechenden Ordner auswählen. Die 

ausgewählten Dateien erscheinen dann so, wie in der folgenden Abbildung dargestellt. Weiter geht es mit Next.

http://www.altium.com
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5. Das Hinzufügen der Eagle™ Library Files (*.lbr) ist optional. Um Bibliotheken im gleichen Arbeitsschritt zu importieren, den 

Add Knopf anwählen und entsprechende Dateien hinzufügen. Weiter geht es wieder mit Next.

6. Mit der folgenden Seite Reporting Options werden Einstellungen für das Protokollieren von Fehlern, Warnungen und 

anderer Ereignisse aktiviert bzw. deaktiviert.

Unter ‚Schematic Settings‘ gibt es außerdem mehrere Optionen, mit denen sich das Import-Ergebnis optimieren lässt:

 � Ports und Power Ports, die in Eagle™ häufig vorkommen, lassen sich in Primitives von Altium Designer verwandeln.

 � Ist die Option ‚Ignore Document Templates’ gesetzt, werden die in Eagle™ verwendeten Zeichnungsrahmen während des 

Importprozesses übersprungen. Nach der Übersetzung lassen sich dann die im Altium Designer zu Verfügung stehenden 

Rahmen verwenden.

 � Durch Aktivieren der Option ‚Hide Default Sheet Template’ wird verhindert, dass Altium Designer den Standardrahmen 

verwendet.

 � Sind im gleichen Arbeitsschritt Bibliotheken importiert worden, können die Library-Einstellungen so angepasst werden, 

dass die Bibliotheken entweder zu dem importierten PCB-Projekt hinzugefügt oder einzeln als Library-Projekt importiert 

werden.

http://www.altium.com
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Zum Fortfahren Next drücken.

7. In diesem Schritt wird das Speicherverzeichnis des importierten Projekts bestimmt. Zum Fortfahren Next drücken.

http://www.altium.com
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8. Als nächstes wird das Messages Panel erscheinen, das eine interaktive Liste von Status-, Warn- und Fehlermeldungen beim 

Import liefert. Dieses Panel kann durch Klicken auf das X am rechten oberen Rand des Fensters geschlossen werden und wird 

beim Bereinigen des Schaltplans noch hilfreich sein.

9. Wenn der Import erfolgreich verlaufen und beendet ist, kann der Import Wizard geschlossen werden. Weiter geht es mit 

Finish – die übersetzten Daten können nun bearbeitet werden.

http://www.altium.com
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BEREINIGEN DES IMPORTIERTEN DESIGNS

PROJEKTMANAGEMENT

Obwohl Schaltpläne und PCB-Designs mit dem gleichen Import Wizard übersetzt werden können, laufen sie als separate 

Prozesse ab. Bei der Umwandlung von Schaltplan und PCB werden die resultierenden Dateien in einem Projekt abgelegt. Im 

vorliegenden Beispiel wurden Schaltplan und PCB von „Arduino_MEGA2560_ref” gleichzeitig durch den Import Wizard geschickt 

und in einem Projekt abgelegt, wie es auch von EagleTM bekannt ist.

Arbeiten mit den in Altium Designer importierten Projektdateien

Weitere Informationen über Projekte finden Sie unter Project Management in den TechDocs. 

SYNCHRONISATION

Altium Designer benutzt für die Synchronisation der Schaltpläne mit dem PCB sogenannte „Unique IDs“. Das ist vergleichbar 

mit einer nur einmal existierenden Seriennummer für jedes Bauteil. Wenn ein Projekt von Grund auf neu in Altium Designer 

erstellt wird, vergibt das System automatisch für jedes platzierte Bauteil im Schaltplan-Editor eine „Unique ID“. 

http://www.altium.com
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Eigenschaften von Komponenten im Schaltplan-Editor

Eigenschaften von Komponenten im PCB-Editor

Bei der Übergabe der Schaltpläne in den PCB-Editor werden diese eindeutigen Kennungen an die entsprechenden Footprints 

übergeben. Im unten gezeigten Beispiel hat das Bauteil mit der Referenzbezeichnung ‚IC3‘ sowohl im Schaltplan als auch PCB 

die Unique ID „BMYDMPBO”. Bei der Übergabe des Designs an den PCB Editor wird auch diese Unique ID übertragen und 

am zugehörigen Footprint im PCB-Dokument angegeben. Im folgenden Beispiel erhält ‚IC3‘ die Unique ID „BMYDMPBO”, die 

sowohl im Schaltplan- als auch im PCB Editor zu sehen ist

http://www.altium.com
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Nach einer Übersetzung eines Eagle™-Projekts sind die „Unique IDs“ den entsprechenden Footprints bereits korrekt zugeordnet. 

Sollte die Synchronisation aus irgendwelchen Gründen nicht durchgeführt worden sein. gibt es ein sehr einfaches Verfahren, 

um die „Unique IDs“ zwischen Schaltplan und PCB abzugleichen. Hier die einzelnen Schritte:

1.  ‘.PcbDoc’ Datei öffnen und Project » Component Links wählen.

Konfiguration der Verknüpfungen von Komponenten zwischen Schaltplan und PCB

Alle Komponenten in den beiden linken Feldern der Dialog-Box haben keine übereinstimmenden „Unique IDs“. Das Ziel 

ist es nun, die Komponenten auf den Schaltplänen mit den zugehörigen  Footprints im PCB mit identischen „Unique IDs“ 

auszustatten. Dies kann manuell geschehen, indem ein zusammengehörendes Paar angewählt wird und mit der Schaltfläche 

> in den „Matched Components“ Teil der Dialog-Box verschoben wird. 

Es gibt auch ein automatisiertes Verfahren, das auf einer beliebigen Kombination von Referenzbezeichnung, Kommentar 

und Footprint-Namen beruht. Da das Design ursprünglich in Eagle™ erstellt wurde, kann man davon ausgehen, dass die 

Referenzbezeichnungen der Komponenten zwischen Schaltplänen und dem PCB identisch sind.

2.  Designator-Checkbox am unteren Rand der Dialog-Box einschalten und Comment und Footprint ausschalten.

3.  Die Schaltfläche Add Pairs Matched By >> anwählen. Dies gruppiert mithilfe der Referenzbezeichnung automatisch die 

Komponenten der Schaltpläne mit den Footprints im PCB.

4.  Um die „Unique IDs“ zu synchronisieren, Perform Update auswählen.

5.  OK drücken.

Nun stehen Funktionalitäten wie Cross-Probing und die Verwaltung von Änderungen (ECO) zur Verfügung. Es ist zu erwähnen, 

dass es nicht zwingend eine eins-zu-eins Übereinstimmung der Referenzbezeichnungen geben muss. Dies kann beispielsweise 

an mechanischen Komponenten liegen, die zur Leiterplatte, aber nicht zum Schaltplan hinzugefügt wurden (z. B. Fiducials). Als 

Komponenten hinzugefügte Befestigungsbohrungen sind ebenfalls eine häufige Ursache für Unstimmigkeiten. Doch auch der 

umgekehrte Fall ist möglich, wenn eine Komponente zwar zum Schaltplan hinzugefügt wurde, um in die Stückliste gelistet zu 

werden, es dafür aber keine physikalische Repräsentation auf dem PCB gibt (z. B. bei einem Kühlkörper).

Altium Designer bietet zahlreiche verschiedene Optionen für Komponenten-Eigenschaften, um das ECO-Verhalten zu definieren. 

Zu den Eigenschaften von Komponenten im Schaltplan- und im PCB-Editor gehört eine Liste verfügbarer Komponententypen, 

wie die folgende Abbildung zeigt.

http://www.altium.com
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Definition des korrekten Komponententyps für einen ECO in Altium Designer

Mehr Information über die unterschiedlichen Komponententypen gibt es in dem Artikel Component, Model, and Library 

Concepts article. 

Einem Bauteil kann jederzeit ein anderer Komponententyp zugewiesen werden. Wird der Typ „Mechanical“ bei einer 

Komponente auf der Leiterplatte angewendet, dann ist die Komponente vom ECO-Prozess ausgeschlossen. Ansonsten würde 

das Bauteil beim ECO-Prozess entfernt werden, weil es keine Repräsentation im Schaltplan hat.

BEREINIGEN DES SCHALTPLANS

Nach einer Übersetzung ist es meist notwendig, ein wenig Aufräumarbeit durchzuführen. Der Grund dafür sind entweder 

Inkompatibilitäten zwischen den beiden ECAD-Systemen oder unterschiedliche Interpretationen von Objektmerkmalen.

In diesem Abschnitt werden nun die Bereiche der übersetzten Schaltpläne behandelt, die üblicherweise überprüft werden 

müssen. Der Anwender sollte dazu ein grundlegendes Verständnis der Benutzung und Funktionsweise von Altium Designer 

haben, um die folgenden Bereinigungen durchzuführen. Ein Tutorial über Altium Designer findet man unter “Getting Started 

with Altium Designer documentation”.

Für weitere Informationen über die gleichzeitige Bearbeitung von mehreren Objekten steht folgender Link zur Verfügung: 

“Editing Multiple Objects technical white paper”.

UNTERSCHIEDE IN DER KONNEKTIVITÄT

In EagleTM ist die Netz-Konnektivität global. Obwohl also normalerweise keine Ports zur Verbindung von Netzen gesetzt werden 

müssen, die sich über mehrere Schaltplanseiten erstrecken, werden diese Ports meist dennoch gesetzt. 

Altium Designer kann sich genauso verhalten, jedoch bevorzugt man meist andere Strukturen. Häufig wendet man ein 

hierarchisches Design an und nutzt Ports und Sheet Entrys für eine definitive und kontrollierte Verbindung zwischen Netzen auf 

verschiedenen Schaltplanseiten. Innerhalb eines Schaltplanblatts können Wires und Net Labels verwendet werden. Zwischen 

verschiedenen Schaltplanseiten werden Netze in einem flachen (nicht-hierarchischen) Design in der Regel mithilfe von Ports 

verbunden. Netze in einem hierarchischen Design dagegen werden von einem Port auf dem unteren Blatt aus mit einem Sheet 

Entry gleichen Namens in dem Sheet-Symbol verbunden, das für das untere Blatt steht. Stromversorgungs- und Masse-Netze 

werden mit Power Ports verbunden. Ports und Power Ports sind dedizierte Elemente in Altium Designer und müssen deshalb 

nicht aus einer Bibliothek heraus platziert werden. Der Importprozess kann Ports und Power Ports automatisch identifizieren 

und umwandeln, allerdings ist es durchaus sinnvoll, dies zu kontrollieren. 

http://www.altium.com
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Zwei grundlegende Unterschiede in der Art und Weise, wie Schaltpläne in Eagle™ und Altium Designer erstellt werden, sollten 

geprüft und falls notwendig repariert werden:

BUSKONSTRUKTIONEN UND KURZSCHLÜSSE ZWISCHEN LEITUNGEN

Diese Konnektivitätsprobleme treten nach Durchlaufen des Projekt-Kompilierprozesses (Project » Compile PCB Project) 

zutage, in dessen Verlauf der ERC (Electrical Rule Check) durchgeführt wird. Im Messages-Fenster erscheinen alle Fehler- 

und Warnmeldungen, die auf etwaige Unstimmigkeiten hindeuten. Dieses Fenster öffnet sich allerdings nur dann, wenn Ihr 

Design Fehler enthält. Um Warnmeldungen zu sehen, müssen Sie es manuell öffnen (View » Workspace Panels » System » 

Messages).

BUSKONSTRUKTIONEN

Da Altium Designer keine gemischten Busstrukturen unterstützt (hier würden stattdessen Harnesses zum Einsatz kommen) 

und die Konnektivität durch Net Labels hinreichend definiert ist, können die Net Labels, die die Busse definieren, ersatzlos 

entfernt werden. Dies bewirkt, dass die Busse nur noch als einfache Linien erscheinen. Nachfolgend wird der Status-Bus 

mithilfe des Labels angeschlossen, um eine logische Verbindung herzustellen.

KURZSCHLÜSSE ZWISCHEN LEITUNGEN

Wird der Endpunkt einer Leitung an einem elektrisch relevanten Element platziert, so wird eine Verbindung hergestellt. In dem 

folgenden Beispiel stellt das Netz ‚EN‘ eine direkte Verbindung zwischen STATUS0 und dem Bus her. Beheben lässt sich dies 

nur, indem man entweder STATUS0 neu zeichnet oder – wie hier geschehen – eine logische Verbindung benutzt.

Fehler und Warnmeldungen im importierten Beispiel

Kurzschluss und falsche Busdefinition Probleme behoben

http://www.altium.com
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Da hier nicht auf alle möglichen Szenarien eingegangen werden kann, empfehlen wir die Lektüre des Dokuments Connectivity 

and Multi-Sheet Design in unserer technischen Dokumentation.

BEREINIGEN DES PCB-DESIGNS

Obwohl der Importer bereits ausgezeichnete Arbeit bei einer Übersetzung leistet, kann es passieren, dass aufgrund von 

Inkompatibilitäten zwischen den beiden ECAD-Systemen eine weitere Bearbeitung des importierten Designs notwendig ist.

DESIGN-REGELN

Große Unterschiede zwischen Eagle™ und Altium Designer gibt es beim Aufbau der Entwurfsregeln. Während Eagle™ einen 

matrixbasierten zugrundeliegenden Regelsatz benutzt, erlaubt Ihnen Altium Designer das Definieren von Regeln nach 

Grundsätzen der Logik und der Mengenlehre, und zwar nicht nur in Bezug auf Breite und Abstand, sondern auch nach einer 

breiten Palette weiterer elektrischer, mechanischer und fertigungsbezogener Kriterien. Es ist deshalb sehr empfehlenswert, 

die Design-Regeln entsprechend diesen zusätzlichen Möglichkeiten anzupassen.

WÄRMEFALLEN IN KUPFERFLÄCHEN

Alle PCB-Systeme behandeln die Erzeugung von Kupferflächen (Copper Pours) und Wärmefallen unterschiedlich. Altium 

Designer benutzt eine grundlegend andere Vorgehensweise beim Erstellen von Wärmefallen, indem die Vorgaben in den 

Design-Regeln verwaltet werden (Polygon Connect Style Rules). Diese Methode gestattet in der Praxis ein zielgerichtetes 

Erstellen von Wärmefallen.

Der grundlegende Aufbau der Eagle™-Daten wird in zwei Regeln berücksichtigt, die während des Importprozesses automatisch 

generiert werden:

Die erste Regel weist alle Vias an, die ‚Flood Over‘-Konnektivitätsart zu nutzen. Erreicht wird dies, indem der Scope nicht auf ‚All‘, 

sondern auf ‚IsVia‘ gesetzt wird und alle Constraints auf ‚Direct Connect‘ gesetzt werden.

Die zweite Regel, deren Priorität geringer ist, definiert alle verbleibenden Verbindungen mit Wärmefallen. In dieser Regel 

können sowohl der Luftspalt als auch die Leiterbreite der Anbindung zur Kupferfläche festgelegt werden.

http://www.altium.com
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Weitere Informationen über das Erstellen von Design-Regeln finden Sie unter Creating Design Rules within TechDocs in 

unserer technischen Dokumentation.

VERWALTUNG VON ÄNDERUNGEN (ENGINEERING CHANGE ORDERS)

Die Durchführung eines ECOs sollte alle verbleibenden Unstimmigkeiten zwischen den Schaltplänen und dem PCB aufdecken. 

Der ECO-Prozess wird unter Design » Import Changes from <project name> gestartet. Unter Umständen wird ein 

Info-Dialog (je nach Situation auch zwei) angezeigt, welcher dazu auffordert, die Netznamen manuell anzupassen.  Es wird 

empfohlen, den Info-Dialog mit No zu schließen, durch die Änderungsliste zu gehen und dann alle Netze umzubenennen sowie 

andere Unstimmigkeiten zu bereinigen.

Bestätigung für die manuelle Anpassung von Netznamen

Obwohl es manchmal nötig ist, einige Änderung vorzunehmen, ist die wichtigste Aufgabe das Umbenennen der vom System 

zugewiesenen Netznamen. Wie bereits im Abschnitt Bereinigen des Schaltplans beschrieben, werden in Eagle™ und Altium 

Designer systemgenerierte Netznamen unterschiedlich erstellt. Es ist empfehlenswert, dass der ECO-Prozess die Eagle™ 

Netznamen in Altium Designer Netznamen ändert, wie in folgender Abbildung gezeigt.

http://www.altium.com
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Systemseitig zugewiesene Netzbezeichnungen in Altium Designer

Eine generelle Steuerung des ECO-Prozess kann unter Project » Project Options definiert werden. Auf diese Weise 

synchronisiert und/oder entfernt Altium Designer eigenständig Netzklassen, Komponentenklassen und vieles mehr.

Synchronisation von Änderungen in Altium Designer

http://www.altium.com
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Es gibt noch eine ganze Reihe von Situationen, die Unterschiede während des ECO-Prozesses zwischen Schaltplänen und 

PCB verursachen können. Es würde den Rahmen dieses Leitfadens sprengen, alle möglichen Szenarien zu beschreiben. Der 

Anwender sollte aber in der Lage sein, die Quellen für Unterschiede auszumachen, indem er die Konzepte nutzt, die Altium 

hierfür zur Verfügung stellt. Weitere Information gibt es in der technischen Dokumentation unter Finding Differences and 

Synchronizing Designs.

Das Ziel sollte es sein, den ECO-Prozess so abzuschließen, dass keine Unterschiede, abhängig von den Optionen in den 

Projektoptionen, zwischen Schaltplänen und PCB gefunden werden.

Diese Meldung informiert darüber,
dass keine Unterschiede gefunden wurden

Es liegt in der Entscheidung des Anwenders, Änderungen zu akzeptieren oder abzulehnen. Die kleine Checkbox in der ECO 

Dialog-Box erlaubt es dem Benutzer, eine bestimmte Änderung vorübergehend zu deaktivieren. Eine permanente Deaktivierung 

von Änderungen kann im ECO Generation Tab der Project » Project Options Dialog-Box eingestellt werden.

Konfigurieren von Projektoptionen für eine ECO in Altium Designer

http://www.altium.com
http://techdocs.altium.com/display/ADOH/Finding+Differences+and+Synchronizing+Designs
http://techdocs.altium.com/display/ADOH/Finding+Differences+and+Synchronizing+Designs
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ÜBERSETZUNG DER BIBLIOTHEKEN

EAGLE™ SCHALTPLAN SYMBOLBIBLIOTHEK

Im Folgenden wird beschrieben, wie eine Eagle™ Symbolbibliothek mit der Dateiendung .lbr importiert wird:

1. Menüpunkt File (oben links) » Import Wizard auswählen.

2. Die folgende Dialog-Box erscheint. Zum Fortfahren Next drücken.

http://www.altium.com
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3. EAGLE Project and  Designs auf der Select Types of Files Seite auswählen und Next drücken

4. Obwohl wie weiter oben beschrieben, Design-Dateien im gleichen Schritt übersetzt werden können, wird die folgende Seite 

mit NEXT übersprungen.

http://www.altium.com
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5. Um die gewünschten Eagle Bibliotheken zu importieren, als nächstes den Add-Knopf anwählen und entsprechende Dateien 

hinzufügen. Weiter geht es mit Next.

6. Auf dieser Seite werden die allgemeinen Einstellungen definiert. Alle weiteren Einstellungen haben keine Relevanz für 

Bibliotheken. Zum Fortfahren Next auswählen.

http://www.altium.com
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7. Als nächstes werden die Ausgabeoptionen für die Bibliothek bestimmt. Weiter geht es mit Next.

8. Wenn der Import erfolgreich verlaufen und beendet ist, kann der Import Wizard geschlossen werden. Weiter geht es mit 

Finish. Die übersetzten Bibliotheken können nun mit Altium Designer bearbeitet werden.

http://www.altium.com
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Nach Beendigung des Prozesses kann die übersetzte Schaltplanbibliothek im Project Panel geöffnet werden

Project Panel im Altium Designer

BEREINIGEN VON BIBLIOTHEKEN

In der Regel werden die Schaltplanbibliotheken und PCB-Footprints akkurat übersetzt. Jedoch können einige kleinere 

Editierarbeiten notwendig sein. Zum Beispiel wird das Verbinden eines Schaltplan-Pins mit mehreren Pads auf dem PCB in 

beiden Tools unterschiedlich gehandhabt. Während Eagle Ihnen die Möglichkeit bietet in der Pinning-Definition einen Pin mit 

mehreren verschiedenen Pads zu verbinden, haben Sie in Altium Designer die Möglichkeit dieselbe Pad-Nummer mehrfach zu 

verwenden, wodurch diese automatisch korrekt verbunden werden. Darüber hinaus wollen Sie sicherlich auch 3D-Modelle zu 

Ihren Footprints hinzufügen um von den 3D-Fähigkeiten von Altium Designer profitieren zu können.

http://www.altium.com
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DIE NÄCHSTEN SCHRITTE IN ALTIUM DESIGNER
Nachdem alle Design-Daten erfolgreich von Autodesk Eagle™ importiert sind, ist es jetzt an der Zeit, sich intensiver mit der 

vereinheitlichten Design-Umgebung von Altium Designer auseinanderzusetzten und die Feinheiten kennenzulernen. Im 

Folgenden sind einige Links zu unserer Dokumentation, Video-Tutorials und Trainings gelistet, die Ihnen helfen werden, Altium 

Designer optimal zu nutzen.

DOKUMENTATION

 � Getting Started with Altium Designer - Tutorial für die ersten Schritte zur Erstellung eines Schaltplans und PCBs.

 � The Altium Designer Environment - Überblick über die vereinheitlichte Design-Umgebung in Altium Designer.

 � Library and Component Management - Dokumentation zur Verwaltung von Komponenten und Bibliotheken. 

Dies ist nur ein kleiner Auszug aus unserem riesigen Archiv an Dokumentation für Altium Designer. Mehr finden Sie unter 

techdocs.altium.com.

VIDEO-BIBLIOTHEK

Unsere Video-Bibliothek enthält viele Tutorials, Erklärungen zu Funktionalitäten und vieles mehr. Hier können Sie sich mit dem 

Altium Designer vertraut machen. Eine Übersicht über alle verfügbaren Videos finden Sie in der Altiumlive Video Library. 

TRAINING

Bevorzugen Sie einen praxisnahen Lernansatz? Registrieren Sie sich für eines unserer Live-Events, darunter Webinare, 

Schulungen und Seminare. Eine Übersicht des Angebots finden Sie unter Altium Events. 

SIE BENÖTIGEN ZUSÄTZLICHE HILFE?

Unser Support-Team steht ihnen für alle Fragen zur Verfügung.

Nehmen Sie direkt mit uns Kontakt auf über die Seite Contact Us.
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